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Those of you who were at the Mi- chuck.fiedler@ntpcug.org
crosoft presentation last year saw a
thought-provoking video on the future of computing from a
Microsoft perspective. I recently saw a video from Dow-Corning which displayed their view of the future. You can see this
video at http://www.youtube.com/watch?v=6Cf7IL_eZ38 .
For another Microsoft video, see http://mervintang.multiply.com/video/item/3 .
All of these speak of a world significantly different from today, where we seem to be chained to our desktops, laptops
and web-enabled phones. As all these predictions point to,
we will be freed to do our web browsing and emailing just
about anywhere.
Of course, all this depends on the development of the
necessary infrastructure. Service providers will need to have
much greater bandwidth than is common today and there
will probably need to be changes in the basic structure of the
internet itself.
These are heady times in the technology world, and much
of what I know about technology has come from my association with the North Texas PC Users Group. Attend our SIG
sessions, whose leaders strive to bring you additional useful
knowledge. Invite your friends and relatives to give us a test
drive and, and hopefully join the Group.
On another subject, I was recently advised that our involvement in the Texas Center for the Visually Challenged
(TCVC) computer refurbishment project has now resulted in
over 4,000 computers being restored and shipped to the visually impaired. This is truly a milestone, and we should all
be proud of our involvement in this effort.
At the upcoming March 19 meeting, Chuck Stark and Gil
Brand will show us how to liven up a system which has become lethargic. The system is mine, and it has truly gotten
pokey. If you also have a system that needs to be sped up
or have some other problem, contact chuck@metroplexcomputerservices.com to get on the schedule for the Windows
Tips and Tricks SIG.
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"Ask Leo!"

NTPCUG Member Websites
by Doug Gorrie

by Larry Weiss

Are you an NTPCUG member? Do you have
a website that you would like to share with other
members? Here is your opportunity to publicize
your hobby, personal interests or perhaps a
business.
NTPCUG now permits each member to post
their name along with one website at www.
NTPCUG.org and in our newsletter. Member
links to be posted are subject to Board approval,
and cannot contain inappropriate content or
promote illegal activities – all the usual conditions that responsible persons expect. Send us
your links now!

I've recently been using an Amazon Kindle
tablet and sampling the available subscriptions that are available on that reader.
One that caught my attention is the "Ask
Leo" technical help series written by Leo
Notenboom. The subscription to "Ask Leo!"
is currently priced at 99 cents per month on
the Kindle.
"Ask Leo" is also available for free at http://
ask-leo.com/ (donations are accepted).
Recent topics include:
* Why don't anti-malware tools work
better?
* What's the difference between memory
and hard disk space?
* How do I resize a partition in Windows
XP?
* How do I turn on "https" in Facebook?
* Does bounced email mean all the recipients didn't get my message?

Here are our current member sites:
Member
Website
Howard Lee Harkness
www.ChoiceTravelTX.com
Bill Parker
www.Partec.net
Bob Hawkins
www.FairviewMicrowave.com
Doug Gorrie
www.JanetGorrieInteriors.com
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Special Interest Groups (SIGs) ...
Sessions with presentations, discussion, and exchanges of information

2nd Saturday

3rd Saturday

These meetings occur at the Microsoft facility at
7000 State Hwy 161, Building 1. See map at http://
www.ntpcug.org/LocationMapsMicrosoft.html.

All meetings at King of Glory Lutheran Church, 6411 LBJ Fwy
in Dallas (between Preston & Hillcrest, north side of LBJ).

.NET Developers – 9:00 am

Building Web Sites — 8:00 am

Tuc Goodwin
tgoodwin@ntpcug.org

Ongoing Series – Learning C#
2010
Chapter 7 -– Controlling Program
Flow – Dave Stark
Chapter 8 – Using Strings and Regular Expressions – Shawn Weisfeld
The book we are using is Teach Yourself
Visual C# 2010 in 24 hours by Scott Dorman,
ISBN: 0672331012, SAMS Publishing.
Here is what we are doing the next five
months:
Tuc Goodwin
4/9/2011
Working with Arrays and Collections
David Stark
5/14/2011
Handling Errors using Exceptions
Shawn Weisfeld 6/11/2011
Understanding Generics
Tuc Goodwin
7/9/2011
Understanding Query Expression
David Stark
8/13/2011
Using Files and Streams
.NET Topics – 10:15 am
Robert Burger will be presenting Introduction to WCF RIA Services (Part 2).
SharePoint – 11:30 am

Alphabetically

Bill Parker, SIG Leader
bill.parker@ntpcug.org
presented by Alan Lummus

We’ll review the Joomla CMS software in
its latest version, and examine where and
how it may have the greatest application.
We’ll also discuss plans for another 2 week,
16 hour marathon event that will have your
own money-making website up and running
before the end of the class. We’ll also review
how others in the SIG have progressed with
the sites they established last year.
Digital Photography — 10:00 am
Spike Smith, NCE
harold.smith@ntpcug.org

Our goals have always been to
take better pictures and to better
adapt them for a specific purpose.
Where shall we get our new information for
making more money and having more fun?
This month, we will exploit what other
professionals, amateur photographers, and
trained technicians do. It is just like we already
do – brag and share information among our
peers and wannabes.
Come on in, observe, and participate as we
learn methods for accomplishing these goals.
Your questions about your camera and hardware are always welcome.

Ram Yadav
ram_yadav@hotmail.com

Topic: Sharepoint 2010
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Digital Photo Editing Software — 11:00
am
Spike Smith, NCE
harold.smith@ntpcug.org

Our goals have always been to
take good image files and adapt
them with our software to physically fit in with
requirements to set the mood. We readily
make image corrections due to environment
or unforeseen problems during image capture. Where we get our new information for
making more money and having more fun includes exploiting data from other professional
and amateur photographers and trained
technicians. Sharing information among
peers and wannabes unleashes a world of
data resources.
Come on in, observe, and participate as
we learn from others in the know.
Internet — 11:00 am

Glynn Brooks
glynn.brooks@ntpcug.org

No meeting in March. See you
in April.
Investors - 1:30 pm
Gil Brand
gbrand@ntpcug.org

We will have an open Q&A session. Bring your questions and we’ll
try to answer them.
IT Professional — 9:00 am - 11:00 am

Larry Copeland, Co-SIG leader
Lacopeland2000@yahoo.com
Mark Phelps, Co-SIG leader
eytukan@gmail.com

No meeting this month to make way for a
special Windows Tips and Tricks presentation, described below. See you in April.
Making Money on the Internet — 9:00 am
Bill Parker, SIG Leader
bill.parker@ntpcug.org
presented by Alan Lummus

In March, we’ll examine ways other than
marketing that the Internet offers to make

money online. We’ll also review the installation
and use of the ECWID shopping cart on a WordPress template website, and we’ll discuss plans
for another 2 week, 16 hour marathon event that
will have your own money-making website up
and running before the end of the class.
Microsoft Access SIG — 11:00 am
Larry Linson
larry.linson2@ntpcug.org

Jim Wehe
jimwehe@gmail.com

On Saturday, March 19, 2011, SIG Member
Chrystin Pleasants will bring some examples
of Excel spreadsheets and we will have a working session to determine Microsoft Access
“equivalents” to accomplishing the purpose
of the Microsoft Excel functionality. Put on
your thinking caps, boys and girls, because we
are all going to participate -- remember it is a
“working session”.
In February, 2011, SIG Co-Leader Jim
Wehe brought a database of personal and family information that he’d originally done in Microsoft Access 2003 and moved to Microsoft
Access 2010 -- it turned out to be a relatively
painless move and made for an informative
presentation. Then SIG Co-Leader Larry Linson showed some examples of calculations in
Microsoft Access Reports and Queries.
Coming attractions: We solicit your suggestions for topics.
We have a couple of suggestions:
From the March base of “how do I do this in
Microsoft Access when I need to move from
Microsoft Excel”, we can proceed on a number
of different paths.
*VBA: When, where, and how to use it
We need to know what topics you’d like to
hear, see, and learn – they can be related to
these, or entirely new. Come to the meetings
and let’s discuss them. Write some suggestions,
add your contact information so we can explore
details if what you want isn’t clear to us, and
give them to Jim or Larry.
A continuing call for presenters: We want
you to show us an Microsoft Access database

4

you created and use, a tutorial on an Accessrelated topic, other Access- or Office-related
material, or to contact a friend of yours who’d
be a good guest speaker. If you need help
constructing the presentation, see Jim or
Larry – we’re not from the government, but
we’re here to help.
Valuable Prizes: We will have a drawing
for a genuine, brand-new Microsoft Arc
Mouse.
Microsoft Certification SIG - 1:30 pm

Tom Perkins
tomperki@gmail.com

We will continue our examination of Business Layer Logic (BLL) object development
for the St.Vincent de Paul project, plus an
Introduction to Reporting Services.

structed with just a text editor, Expression
Web (EW) has many tools and screens that
help you do it properly and efficiently. For instance, to get you off to a fast start, EW has
some templates that make for fast creation of
a website. Once created, it is a much simpler
process to modify the site settings to get what
you want, rather than having to start from
scratch. But we’ll look at doing it both ways.
You’ll see the proper and recommended way
to structure a webpage – using styles and
<div> elements instead of <table>’s. Be sure
to come with your questions, too. We want to
make this as helpful to your website development project work as possible.
Mobile Computing — 10:00 am
Gil Brand
gb1@ntpcug.org

Chuck Stark
chuck.stark@ntpcug.org

Questions or comments?

Contact Tom Perkins (tomperki@gmail.com) or
Chris Morgan (chris.morgan@ntpcug.org)

No information available.

Microsoft Excel – 8:00 am

Frank Tubbs, SIG leader
ftubbs@sbcglobal.net

The Excel SIG will continue to look at how
Excel 2007 and 2010 features appear differently, but still get you the expected results.
Recently, I have been playing with the SORT
and FILTER features. The SORT feature has
been expanded. Applying it has a different
appearance and additional depth. FILTER has
not changed in function, but the application
is more graphical. These are two very useful features, so knowing how they function is
worthwhile.
Microsoft Expression Web — 10:00 am
Chris Morgan
chris.morgan@ntpcug.org

Powershell – 9:00 - 10:00 am
Larry Weiss
lfw@airmail.net

Gil Brand
gbrand@ntpcug.org

The PowerShell class using examples from
the book “Learn Windows PowerShell in a
Month of Lunches” by Don Jones continues
in March, followed by a Q&A session.
Windows Inside Out — 12:30 pm
Glynn Brooks
glynn.brooks@ntpcug.org

No meeting this month. See you
in April

Windows Tips & Tricks — 8:00 - 9:00 am
In March, we will cover chapters 3
Gil Brand
and 4 of our text, Sams Teach Yourgb1@ntpcug.org
Chuck Stark
self Microsoft Expression Web 4 in 24 Hours.
chuck.stark@ntpcug.org
These chapters are about what constitutes a
website and what a webpage consists of – a
topic we got into briefly at our last meeting.
*** SPECIAL THREE HOUR PRESENTAThis time, we will dive into it in more depth.
TION ***
While a website and its pages can be conWe will have an open Q&A session as well
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as a special Live, No Net presentation on reviving a sluggish computer. As always, if you
have a troubled system and want to bring it in,
we will use it for a ‘live, no net’ troubleshooting
session. Please contact Gil or Chuck prior to
the meeting to discuss.
Wireless Communications — 11:00 am
Birl Smith
birl.smith@ntpcug.org

Wireless Communication In March
we will talk about the advantages of
using a virtual machine or dual booting a computer. Dual booting and virtualization is a way
to evaluate operating systems and software.
Virtualization is good for evaluation because
changes can be easily removed. Booting
multiple operating systems has challenges
because the last operating system installed
will be the first operating system booted.
Word — 9:00 - 11:00 am

Sharon Dorsey
Sharon.Dorsey@ntpcug.org

Word Options
It took us three sessions to complete our exploration of the Office
Button, but we did it! As they say, third time’s
the charm.
In Word 2003 in the Tools>Options menu,
there is a multitude of options such as how to
view, edit, print and save a document. Also,
you define spelling and grammar rules in the
Tools>Options menu.
In Word 2007, all of this is found in Word
Options, which is located in the Office Button
menu. At the February meeting, we covered the
Proofing, Save, Advanced, Customize, Add-Ins
and Trust Center menus in Word Options. Here
are some highlights in each menu.
Proofing
AUTOCORRECT OPTIONS
This is a dialog box also found in Word 2003.
Therefore, the shortcut keys (Alt-T-A) used to
access the dialog box in Word 2003 is available
in Word 2007. This gives you quicker access
instead of going through Word Options. In addition, if you change formatting in a document

and see the lightning bolt icon, it will take you to
the Autocorrect dialog box.
In the Autocorrect tab of the dialog box, there
is a section Replace text as you type. You can
add a word or abbreviation and tell the program
to replace it with multiple words. For example,
add your initials and tell Word to replace it with
your name or insert a whole phrase by typing in
a few letters. Excellent time saving feature.
Have you ever noticed purple underlines in a
Word document? If you have, it’s because Word
has identified a name, date, phone number, etc.
as a Smart Tag. Hover your mouse over the Smart
Tag and you will see a circled i. Click on the down
arrow next to the circle for a dropdown menu. You
can then use the Smart Tag to update contacts
or schedule a meeting in Outlook.
What is the difference between the Auto Format As You Type tab and Auto Format tab? The
first one does exactly as it is named; your document is formatted as you type according to which
options you have selected. If you turn off all of the
options in the As You Type tab, you can choose
the same formatting options in the Auto Format
tab. You’ll see format changes once you highlight
text and press the shortcut keys Alt-Ctrl-K.
In the Auto Format As You Type and Auto
Format tabs, you find automatic formatting for
fractions (½ vs. 1/2), ordinals (1st vs. 1st), smart
or straight quotes (“x” vs. “x”) and dashes with
hyphens (-- vs.—).
If you have ever pressed return twice after typing the first line of a document, you have seen
your text reformatted to Word’s Heading Style
1. That is because of the Built-In Heading Styles
option found in these tabs.
SHOW READABILITY STATISTICS
This is useful information if you are writing
a school paper and need to keep track of how
many words are in your paper and at what grade
level you are writing.
WRITING STYLE
Setup your spelling and grammar preferences in this dialog box.
Save
If you make no other changes to Word
Options, this screen contains the one option you
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should setup. Set you Save AutoRecover Information to the number of minutes of work you are
willing to risk losing if your document experiences
a shutdown. Sorry, there is nothing less than one
minute!
Advanced
EDITING OPTION
Here you find several options that can make
editing your document easier. For instance, replacing all highlighted text or selecting an entire word
even if you position your mouse in the middle of a
word. In addition, this is where you tell Word you
want to use Ctrl-click to open a hyperlink on the
Internet.
CUT, COPY, PASTE
Show Paste Options buttons, let’s you
establish which format to use when copying and
pasting text between documents with different formats. You can keep formatting from your original
document or change to formatting in your new
document.
SHOW DOCUMENT CONTENT
If you have a long document with many
pictures and want to scroll faster, you can turn off
their display in the Show picture placeholders.
The pictures will print when display is turned off.
DISPLAY
Well hidden but definitely in the top five
things most people want to change is the number
of recent documents displayed in the Office Button. You can show up to 50 documents, which you
have worked on.
PRINT
Not all printers can print a document in
reverse order so you don’t have to resort. The option to Print pages in reverse order solves this
inconvenience.
Customize
Remember the Quick Access Toolbar from
our November session? The Quick Access Toolbar
allows you to customize Word 2007 by placing any
function you perform often on the toolbar. This
menu accesses the same dialog box for you to
setup your most used functions. Don’t forget you
also have the option to move the toolbar below the
Ribbon view for quicker access.

Add-Ins
You’ll see a list of active applications
that have been added to Word 2007. For instance, if you have downloaded the Acrobat
PDFMaker from Microsoft’s website (http://
www.microsoft.com/downloads/en/details.
aspx?FamilyId=4D951911-3E7E-4AE6-B059A2E79ED87041&displaylang=en), it will be on
the list.
Trust Center
TRUST CENTER SETTINGS BUTTON
If you are tired of working in Word and
being asked to send Microsoft information,
this is where you can turn off those requests.
It also lets you decide if you want to connect
to the Internet for Word Help.

Our Monthly Flyer –

Can You Help Distribute?
Each month, we send members a flyer listing
the upcoming second and third Saturday SIG
meeting information. We work to fit it all on one
page so it can be easily printed and posted in
offices and public areas. It can also be sent by
email to family members, friends, colleagues,
etc.
With your help we hope to generate increased
interest in User Group activities, thereby helping us grow. We rely on members, SIG leaders,
Board members and volunteers to share this
information with others. We also need you to
consider new options beyond the obvious – bulletin boards, etc.
We ask you, our members, to think of places
where you can post the monthly flyer and to
e-mail it to anyone you know who may be interested.
With your help we can grow our Group and
reach others who can “Share what you know,
learn what you don’t.”

Where have you sent
the March flyer?
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News from the Northwest
By Teresa Hennig

Re-Introducing Teresa Hennig
Teresa Hennig is lead author of several technical
books on software development published by various
national publishing firms, and Owner and Principal Developer of Data Dynamics NW in Seattle,
Washington. Data Dynamics NW provides data
management solutions for all types of businesses
and specializes in helping organizations efficiently
manage, utilize and profit from their data. Teresa
enjoys working with her clients and collaborating
with other developers to match project needs with
developer expertise.
Her volunteer efforts include working with
INETA (The International Dot Net Association), in
which organization, she was recognized as a Community Champion in 2009, consulting and creating
pro bono database application software for charitable
and non-profit organizations, and leading both the Seattle Access Group and the Pacific Northwest Access
Developers Group. She is recognized by Microsoft as
a Most Valuable Professional (MVP) for her contributions to the Microsoft software user community.
She puts in considerable time and effort compiling this list of Access- and developer-related items
and has graciously agreed to share it with the North
Texas PC User Group. For some time, this information was included in the NTPCUG Microsoft Access
SIG Notes, but because of its appeal to a broader
audience, it has been promoted to article / column
status. Teresa is also an NTPCUG member.
Many thanks, Teresa, for sharing your efforts
with us.
I extend my sincere sympathy to Teresa. Her Mother, Margaret Meacham, passed away on Monday, Feb.
28, after a long illness and series of strokes. Teresa
posted a memorial on her website at http://www.
datadynamicsnw.com/Mom.htm. (Larry Linson)
Note: Seattle Access Group (SAG)and Pacific
Northwest Access Developers newsletters can
be found at the Seattle Access Group website
at http://www.SeattleAccess.org

Downloads, Updates and Other Good
Stuff
Choosing between Windows Azure Table
Storage and Windows SQL Azure - Intertech
paper (Jan 2011)
If you are looking at options for moving data to
the cloud, you may benefit from Jim White’s (Intertech) article that discusses some of the basic
features and differences of the two platforms.
http://www.intertech.com/Blog/post/WindowsAzure-Table-Storage-vs-Windows-SQL-Azure.
aspx
Data Conversion in SQL Server Article by
Simple-Talk, Robert Sheldon (Jan 2011)
We’ve often had discussions about compatibility and consistency between Access and SQL
Server and associated with data, data types,
syntax and queries. Robert’s paper covers issues related to data conversions, truncated data,
performance impacts and more.
http://www.datadynamicsnw.com/seattleaccess/www.simple-talk.com/sql/t-sql-programming/data-conversion-in-sql-server/?utm_
source=simpletalk&utm_medium=emailmain&utm_content=DataConversion20110110&utm_campaign=SQL
Optimizing Hyper-V Performance - Three
Part Webcast by Tech Republic (Jan 2011)
Session 1 - Top Considerations for Optimizing
Hyper-V Performance; crash course on virtualization; top consideration for optimizing performance; architecture basics; managing storage.
Session 2 - Efficient Hyper-V Management
and Performance
Session 3 - Improving Hyper-V Performance
and Scalability
http://www.techrepublic.com/webcasts/webcast-top-considerations-for-optimizing-hyper-vperformance/2324535
Office 2010 Compatibility Guidance -- Microsoft TechNet (Dec 2010)
Find guidance and information about require-
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ments, product and compatibility issues.
http://technet.microsoft.com/en-us/office/
ff460851.aspx

using virtual environments for development
and supporting client applications. This free
web seminar will provide valuable guidance
that will make the tasks easier and more effective.
h t t p : / / w w w. w i n d o w s i t p r o . c o m / r e source/virtualize-sharepoint-and-sqlserver-now-maximize-efficiency-andavailability-with-hyper-v-r2-and-netapp.
aspx?code=epdedNetAppQ211WS01_SQL

Basic Windows 7 Deployment Help from
TechNet (Dec 2010)
Ramp up the learning curve and take the easy
route by following some of the tips from TechNet.
http://technet.microsoft.com/en-us/edge/basicwindows-7-deployment.aspx

RESOURCE TIPS:

Removing Crapware - from TechRepublic
(Nov 2010)
One of the annoyances of a new computer is
the amount of crapware that comes preinstalled.
TechRepublic has a free report with suggestions
and tools for identifying and removing unwanted
programs and files. It also mentions why you don’t
want to defrag Solid-state drives (SSD), such as
those in some high-end laptops.
http://www.techrepublic.com/blog/five-tips/fivetips-for-getting-rid-of-crapware/345

Access Blog – by the Access Team --one of the top blogs on MSDN!!!
Stay tuned to the community … The team
shares insights into their schedule, their
favorite features, new features and how to
use them. This is also an ideal avenue for
the team to talk about issues that are of interest to the Access community. You’ll learn
about the people and some of the factors that
are helping to shape the future of Access.
Whether you’re a seasoned developer or just
learning about Access, you’ll find invaluable
information and techniques. From creating a
database template to getting help when you
need it, The Access Blog covers the gamut.
http://blogs.msdn.com/access/default.aspx

Microsoft Internet Explorer 9 Beta (Sept
2010)
See how Explorer 9 can bring your desktop
and web experiences closer together in a safer,
more consistent and productive environment.
http://www.microsoft.com/presspass/presskits/
internetexplorer/
AquaSnap 1.3 - Arrange Windows on Your
Desktop (Sept 2010)
Nurgo Software offers a free tool that allows
you to snap and anchor windows to the edge or
corner of your desktop. It is compatible with all
versions of Windows and can replace Aero Snap
and Aero Shake in Windows 7. Read more and
get the download at
http://www.nurgo-software.com/products/
aquasnap.

Access 2003 Solution Center
Find the materials and answers that you
need for Access 2003. Downloads, articles,
tutorials and other reference materials are
conveniently listed in an easy to search fashion. Check out
http://support.microsoft.com/?scid=ph;enus;2509
A couple of good sites to search for information and programming assistance are
http://www.mvps.org and http://msdn.microsoft.com/en-us/office.

Webinar on Demand - Running SharePoint
or SQL Server in a virtual environment (Sept
2010)
Many of us may be planning to or are already

And, we’ve been mentioning the newsgroups. You can search and drill through
thousands of threads. You may also find
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what you are looking for by using http://groups.
google.com or try http: www.google.com/microsoft.html for Microsoft related pages or by
setting multiple search criteria at http://www.
google.com/advanced_search?hl=en.
Utter Access Discussion Forum
Touted as the number one Access community forum! This may be a great place to get
answers to your questions. And, you’ll see several familiar names as some of our members
are prolific posters. Hey, there are even photos
from the MVP Summit, so check it out! http://
www.utteraccess.com/forums/index.php
A compilation of links to Access Resources
This site provides an impressive array of
links to a variety of resources for Access
developers and users. http://www.cbel.com/
ms_access/
Dynamic Link Library Article by Mark
Liron, MVP
Learning more about DLL’s is in ongoing
theme, so you might want to bookmark or
download this page. http://www.updatexp.com/
dynamic-link-library.html
Access Developer Portal MSDN
Database samples and tutorials provided by
Access MVP and other experts.
http://msdn2.microsoft.com/en-us/office/
aa905400.aspx
DATA BASE CHECKER
Access MVP, Allen Browne offer tips and
utilities for casual users through expert developers. The Issue Checker can be used during
development or to trouble shoot legacy files.
Allen’s site provides a host of other tips and
resources, including a compilation of reserved
words. http://allenbrowne.com/ or http://allenbrowne.com/AppIssueChecker.html .

Volunteering
Every board member, officer, chairman, and
SIG leader is a volunteer. No one in this organization receives any payment for their work. Without our volunteers, NTPCUG would not exist.
Please consider volunteering for one of these
important jobs:

Information Desk — Charles Rem
crem@ntpcug.org

Assist with check-in process at 3rd Saturday.
One or more hours will make a difference.

Mentoring — Tom Sweet
tom.sweet@ntpcug.org

Communicate with new members to ensure
they are aware of the benefits, SIG opportunities
and help them in numerous ways to feel welcome
and to know that we care about them.

Newsletter —
Doug Gorrie, Chuck Fiedler,
David Franke
doug.gorrie@ntpcug.org
chuck.fiedler@ntpcug.org
davef81@gmail.com

Prepare, contribute to and distribute the
monthly newsletter.
------------------------------------------------------

Trigeminal Software, Inc, is Michael Kaplan, Seattle Access’ and Pacific Northwest Access Developers’ VP for Backwards Compatibility and co-host
of the Q&A sessions. To learn a little about Michael
and to download some valuable tools, please visit
his web site at http://www.trigeminal.com/. The site
offers free utilities, sample code and links to numerous articles and postings … and, as I mentioned …
you should really avail yourself of the opportunity to
read some of his opinions (not that Michael would
voice anything controversial <g> ). For entertaining
and edifying reading, check out “Sorting It All Out,”
http://blogs.msdn.com/michkap .
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This Month in Our History
For some reason, the writing of this column
always seems to slip by me unnoticed until
the need is critical. So here it is, the second
week of March, and I’m finally getting around
to writing this month’s column. We’re going to
look at the happenings of our club in March of
1986 and 1991.
In March of 1986, Michael Labanowski,
Major Account Representative for Microsoft,
presented this new-fangled thing from Microsoft called “Windows.” Michael also offered
three copies of Windows, Word and Project
for the member drawing.
Novell Regional Manager Steve Rucker
made a presentation on how their product
could permit information sharing between
separate computers. No mention was made
in the newsletter of any product offered for
door prizes.
Fischertechnik President Rone Lewis and
Vice-President Mike Standley demonstrated
their line of remote computing kits. According
to the announcement, with this software you
can construct a traffic-light control project and
even construct other projects up to the ultimate
project, a solar tracking system. They also
provided product for giveaways.
Member Jim Hoisington wrote an article
titled Video Adapter Features in which he
detailed the various features for everything
from the then-standard monochrome monitor
through the new IBM EGA (Enhanced Graphics Adapter). Jim noted how each adapter had
its various and unique capabilities. Of course,
today we don’t usually have to worry about
installing a variety of possible video cards.
More and more, we simply plug our flat screen
monitor into the USB port and bash on.
Editor John Pribyl wrote a review of AccuTax from AccuSoft software. He proclaimed
it a winner. To use the product, all you needed
was an IBM compatible PC with 192K of RAM,
a 360K disk drive, DOS 2.0 or later and an
80-column display. AccuTax was $35 for the

by Chuck Fiedler
chuck.fiedler@ntpcug.org

1986 shareware.
SIG reports were provided for Advanced
Programmers, APL Language, Artificial Intelligence, Basic Applications, Business Applications, C Programming, Communications, Genealogy, Integrated/Spreadsheet, Investment,
and Turbo Pascal, showing that the majority
of our SIGs at that time were aimed at the
professional user and the rather advanced
hobbyist.
In 1991, the main presentations were
on Quicken and Corel Systems. Quicken
Evangelist Richard Katz presented Saving
Time with Quicken. Three copies of software
were donated for door prizes. Senior Product
Specialist Kim Sheeren from Corel made a
presentation on Corel Draw. Again, there was
a drawing for free software.
President Jim Hoisington wrote in Prez
Sez about the various happenings in selected
SIGs and encouraged PC News readers to
read the SIG notes each month for an idea of
what is going on in the various SIGs.
Again my favorite column at the time, The
Variety Store by Reagan Andrews noted that
the breakout of war in Iraq and Kuwait had
managed to take his attention off happenings
in the technology world. Reagan’s paying gig
was as a VA counselor to service veterans
returning from conflict. US psychological
rehabilitation followed treatment for physical
wounds treated in military hospitals, primarily
in Saudi Arabia and Europe. He further noted
that publicity about the Desert Storm operation had caused veterans of WWII, Korea and
Vietnam to seek PTSD treatment as they were
reliving their experiences then.
Reagan went on to report on the divorce of
Microsoft, producer of Windows, from IBM,
producer of OS/2. The prior year, Microsoft
CEO Bill Gates had promised the coming
of Windows 3.1 which included OLE (Object
Linking and Embedding), a greatly improved
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file system over that in DOS and earlier versions of Windows, and support for TrueType
fonts. He noted that there was a proliferation
of font offerings from various developers and
mentioned the development of TrueType fonts
by Microsoft and Apple.
If you were a member of NTPCUG back
then, you will remember the BBS forum where
members could post comments, problems and
answers to those problems. These were organized according to the SIG most closely related
to the topic of discussion. A number of pages
of postings were included under the heading
Happenings on the BBS.
Jim Hoisington wrote his 49th installment
of On Complexity, in which he dealt with bus
structure of PCs, beginning with the 8-bit and,
later, the 16-bit ISA (Industry Standard Architecture) bus, through ICMs MCA (Micro Chanel
Architecture) to EISA (Extended Industry Standard Architecture). Today, 32-bit computers are
slowly being replaced with 64-bit units. Every
time the bits are expanded, we see greater and
greater possibilities in software.
There were ten Disk-of-the-Month (DOM)
offerings. System requirements were expanding to the point where a minimum of 512K of
RAM and DOS 2.1 or 3.0 were recommended,
although a hard disk was recommended but
not essential.
Thanks for reading. If you wish to see the full
historic newsletter issues, log on to our website,
WWW.NTPCUG.ORG.

Displaying a Hidden First
Column
Excel makes it easy to hide and unhide
columns. What isn’t so easy is displaying a
idden column if that column is the left-most
column in the worksheet. For instance, if you
hide column A, Excel will dutifully follow out
your instructions. If you later want to unhide
column A, the solution isn’t so obvious.
To unhide the left-most columns of a worksheet when they are hidden, follow these

steps:
1. Press F5. Excel displays the Go To
dialog box.

The Go To dialog box.

2. In the Reference field at the bottom of
the dialog box, enter A1.
3. Click on OK. Cell A1 is now selected, even though you cannot see it on the
screen.
4. Unhide the column. (In Excel 2007 or
Excel 2010, display the Home tab of the ribbon and click Format | Hide & Unhide | Unhide
Columns. In older versions of Excel choose
Format | Column | Unhide.)
Another way to display the first column is
to click on the header for column B, and then
drag the mouse to the left. If you release the
mouse button when the pointer is over the
gray block that marks the intersection of the
row and column headers (the blank gray block
just above the row headers), then column B
and everything to its left, including the hidden
column A, are selected. You can then unhide
the column.
A third method is even niftier, provided you
have a good eye and a steady mouse pointer.
If you move your mouse pointer into the column
header area, and then slowly move it to the left,
you notice that it turns into a double-headed
arrow with a blank spot in the middle as you
position the pointer over the small area immediately (cont’d - see Displaying on page 17)
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Career advice (from a lawyer)
It is the New Year. Time for taking stock, assessing one’s career, and planning for next year.
It is a busy time for everyone. Now is the time (or
past time) to start planning for the coming year
and generally thinking about what’s next in your
career development.
If you don’t believe me, let’s put this need into
some perspective. I am going to use an analogy
that will be familiar to all those of you who are
married. How long did you plan for your wedding? I would bet that on average the planning
time was between six months and one year. Now
that leads to the next question: How long did the
wedding last? A few hours, maybe a day and an
evening, right? Okay, now let’s ask a different
set of questions: How much time did you spend
planning your career? Was it less than a year?
How long is your career going to last you? See
the irony? Your career will last you much longer
than that moment in time. It is important to, on
a regular basis, for each of us to spend the time,
to assess where we are at and where we want
to be going.
A few years ago, I discovered a career development book written by David Maister. Mr. Maister
is a former Harvard Business School professor,
American writer and expert on business management practices and the management of professional service firms. He has written several books,
including one that I give to all of my counselees
titled True Professionalism (ISBN: 978-68484004-8). Mr. Maister retired in 2009, but I have
found his books to be timeless.
I recently read something on one of Mr. Maister’s older blog post that describes “how to have
a successful career” that I thought I would share
with you. As you read it, substitute “Lawyer” and
“Law” with “Professional” and “Computing” or in
some cases “computers” or “[your favorite programming language].”
“First, be someone others count on. Most
folks talk a good game; very few come through.
Clients come to you because they have a situation they cannot solve on their own. Most are
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by Tuc Goodwin

not looking for an tgoodwin@ntpcug.org
analysis of the law.
Most want you to solve a problem. So
solve it, don’t add to their problem by being hard to find, by missing deadlines, or
by simply describing their problem back
to them. It’s like going to the dentist when
you have a toothache. You want it fixed
and you want it fixed now. That’s what a
client wants every time they talk to you.
Walk in with a problem, walk out with a
solution.
What they want is someone they can
count on to make their lives simpler, to
accomplish what they want accomplished.
If you can simply do that, you’ll be sought
out as an extraordinarily effective lawyer.
And there is a real difference in your sense
of self between being simply a resource;
somebody who knows the law, and the
person that people count on to solve their
problems.
Second - be an interesting person, for
your own good and so that clients think of
you as more than a lawyer. A decent definition of hell is a dinner party companion
who is a first year lawyer on the day after
his or her first trial. Law stuff is interesting
mostly to lawyers. In fact, it’s real interesting to lawyers, so that’s what we talk
about all the time, just like you talk about
law school all the time.
Force yourself to do be able to talk about
more than law - read books, go to movies,
be part of politics, go to lectures. You’ll
meet people, you’ll be able to talk about
things that other people find interesting,
and you won’t burn out on your job.
The horror stories you hear about associates working 2500 hours a year? You will
be surprised when you see how much of
that is self-imposed. These young lawyers
get caught up in the chase and find that
what they’re doing more interesting than

anything else- so they become that boring
self-absorbed dining companion. The world’s
full of great people with jobs and hobbies that
are just as demanding and just as fascinating
as yours, (assuming you make yourself get a
hobby). Learn about them. You’ll be happier
and much more fun to be with.
Here is another obvious but ignored truth.
Look out for yourself. Nobody cares about
you like you do except maybe your parents,
and you won’t be working for them. My late
and very wise father used to tell me to not
worry about what people were thinking about
me, because they weren’t. They were thinking
about themselves.
Your employer may have a mentoring program, but nobody is mentored into a success.
Mentors are important, but they are only a
resource. Accept that you are in charge of
your success.
So if you think you need experience in an
area, make it your business to go get it. Ask
somebody; don’t wait for it to come along.
Don’t wait for somebody to notice that you’re
missing an important skill. Ask for a promotion - people aren’t watching what you do as
carefully as you think or hope.
Also, determination matters. It matters
more than intellect. The streets are littered
with directionless geniuses with unexecuted
good ideas. . Woody Allen had it pretty dead
on when be said that 90% of success is simply showing up. You won’t suddenly have a
great career. Nobody ever does. The secret is
simple- great careers are the result of day
after day deciding to do good work and
being someone who others count on.
Be enthusiastic. Because we deal in rules,
it’s real easy to fall into cataloging all the reasons something won’t work or why somebody
shouldn’t do something. In fact, we lawyers
take pride in being the first one to find fault with
an idea. Makes us look smart. In my days as
managing partner I would roll out a strategic
initiative, and I could see my partner’s eyes
starting to spin. Who would get the prize for
being the first one to spot the flaw?

Clients want to do things - they don’t call you
so they cannot do things. They want to stay in
the borders of the law, but they want to be told
how to do what they want to do. And they want
to know that you’re happy to be part of what
they’re doing. There is no better way to end
a client meeting than saying “This is going to
be great” and to mean it. It’s fun to be charged
up - to add energy to every conversation.
Trust yourself. You are a very bright person
or you wouldn’t be here today. I think among
the most important conclusions I came to as
a young lawyer was that if I didn’t understand
something, it was because the thing in fact
didn’t make sense, not because I was stupid.
Most of the times I’ve found myself in hot water
it’s because I let a conversation continue past
the point where I understood what was being
said. And virtually every time I would say “stop,
I’m not following this,” someone would come
up to me after the meeting and say “Boy I’m
glad you said that. I had no idea what we were
talking about.”
Get involved. Organize the reunion or the
bicycle race. Chair the church committee.
Help people who have not enjoyed your good
fortune. You have spent three years learning how to organize your thoughts, analyze
a situation, and articulate action plans. Use
those skills everywhere in your life. Stuff will
get done, people will appreciate your initiative,
and you will derive great satisfaction from
making things better.
Here are my final two unappreciated but
clearly true truths: The toughest lawyer is
not the one who is the most obnoxious.
Clients will say they want a tough son of a
gun to make somebody life’s miserable, a real
bulldog, etc.
Don’t be that person. It’s been my 100%
uniform experience that the bulldog only adds
time, expense, stress and confusion to an
otherwise inevitable result. Even clients can’t
stand them after a couple of months. You want
to be tough? Have the best preparation on the
facts, the law and the strategy. Judges care
only about those things, not a whit for bluster.

14

Bullies are jerks, they wreck the profession
for everyone, and you can beat them every
time.
And finally and hands down, most importantly and please pass this on to your friends
and your children, because it’s really important — Be nice and have fun. Just doing that
makes life better for everybody, mostly you.
And now really finally, and this is not a truth,
but what I think you should do - thank the
people who have helped you get to where you
are today, and fully enjoy this moment - you
have earned it. “

Note: If you want to read the unexpunged version, you can find it at http://
davidmaister.com/blog/602/Being-a-Happy-and-Successful-Lawyer
Finally, let me leave you with this thought
about career planning: How old will you be
in five years if you don’t plan your career?
People (usually) do not regret the things
they did, as much as they regret the things
they didn’t do.

.
NTPCUG NEWSLETTER AD RATES AND DESCRIPTION
Paid advertising is available within the North Texas PC News at reasonable rates. The online Newsletter is published monthly and is distributed in PDF format to approximately 200 registered members.

SIZE

Price / One Issue

Price Each - Six Issues

Full Page

$120

$ 85

Half Page (vertical)
Half Page (horizontal)
Quarter Page
Business Card
NTPCUG Members

$ 75
$ 75
$ 50
$ 35

$ 65
$ 65
$ 40
$ 25
Half Price

Policies & Mechanicals
•
Commercial ads –
o
repro form, final size, ready for printing
o
JPEG or approved format
o
300 DPI minimum
•
Text ads should follow most commonly used font styles
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(Cont’d from page 12)
to the left of the of column B header. This double-headed arrow is a bit difficult to describe; it
looks most closely like the double-headed arrow that appears when you position the pointer
over the dividing line between column headers.
It is different, however, because instead of a
black line dividing the double arrows, there are
two black lines with a gap between them.
Copyright © 2011 by Sharon Parq Associates, Inc.
Reprinted by permission.

Printing Odd or Even Pages
There may be many times that you need to print either odd or even pages in a print job. For instance,
you may want to put your pages through the printer
twice so you can print on both sides. This is easy to
do in Word by following these steps:
1.
Press CTRL+P. Word displays the Print dialog box.

Times Are Tough
in the USA
How can you tell?
• CEOs are now playing miniature golf.
•
•
•
•
•
•
•
•
•
•

Exxon-Mobil laid off 25 Congressmen.
If the bank returns your check marked
“Insufficient Funds,” you call them and
ask if they meant you or them.
McDonald’s is selling the 1/4 ouncer.
Prents in Beverly Hills fired their nannies
and learned their children’s names.
My cousin had an exorcism but couldn’t
afford to pay for it, and they re-possessed
her!
A picture is now only worth 200 words.
When Bill and Hillary travel together, they
now have to share a room.
he Treasure Island casino in Las Vegas
is now managed by Somali pirates.
Congress says they are looking into this
Bernard Madoff scandal. Oh Great!
The guy who made $50 Billion disappear
is being investigated by the people who
made $1.5 Trillion disappear!

2. Adjust the printing settings as desired.
3. Using the Print drop-down list at the bottom
of the dialog box, choose either Odd Pages or Even
Pages, as desired. (Make sure you use the Print
drop-down list, not the Print What drop-down list.)
4. Click on OK. Your document is printed.
The above steps work great in any version of Word
up through Word 2007. If you are using Word 2010,
then the Print dialog box was done away with. You
should follow these steps, instead:
1. Press CTRL+P. Word displays the File tab of
the ribbon, with printing options visible in the tab.
2. Adjust the printing settings as desired.
3. Using the first drop-down list under the Settings heading, choose Only Print Odd Pages or Only
Print Even Pages, as desired.
4. Click on Print. Your document is printed.
Copyright © 2011 by Sharon Parq Associates, Inc. Reprinted
by permission.
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Emeritus Members

Thank you!
from your 2011

Board of Directors and Officers

John Pribyl (1924 – 1993)
Reagan Andrews ( - 2006)

President:

Connie Andrews ( - 2008)

Chuck Fiedler
chuck.fiedler@ntpcug.org

Phil Chamberlain
President-Elect: Bill Drissel
bill@drissel.us

Jim Hoisington
Guy Andrews

Directors:

Stuart Yarus
Timothy Carmichael

Larry Copeland
larry copeland@ntpcug.org
Jesse Hastcoat
jesse.hastcoat@ntpcug.org

Mark Gruner
David McGehee

Chris Morgan
chris.morgan@ntpcug.org

Tom Prickett
Kathryn Loafman

Spike Smith
harold.smith@ntpcug.org

Fred Williams
Andy Oliver

Chuck Stark
chuck.stark@ntpcug.org

Alex Lilly
Doug Gorrie

Secretary:

Kathy Lee Brown
KathyLeeBrown@live.com

Treasurer:

Chuck Stark
chuck.stark@ntpcug.org

Program
Director:

Howard Lee Harkness
Programs@ntpcug.org

Claude McClure
Robert McNeil
Gil Brand
Bill Parker
Diane Bentley

Calendar
March

April

12 9:00 am—Noon 2nd Saturday
at Microsoft

9

19 8:00 am—2:30 pm 3rd Saturday at King of Glory

16 8:00 am—2:30 pm 3rd Saturday at King of Glory

9:00 am—Noon 2nd Saturday

at Microsoft

May

14 9:00 am—Noon 2nd Saturday
at Microsoft
21 8:00 am—2:30 pm 3rd Saturday at King of Glory

North Texas PC Users Group, Inc.
P.O. Box 700055
Dallas, TX 75370-0055
Copyright 2011 North Texas PC Users Group All rights reserved.
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